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Skyline Custom and Live Reports  

The Skyline Targeted Proteomics Environment provides informative visual displays of the raw mass 

spectrometer data you import into your Skyline documents.  It allows you to work with this data, to 

refine the peptides and transitions you are measuring and to tune integration boundaries.  A rich variety 

of calculated values and statistics may be exported from your Skyline document to a tabular comma 

separated value (CSV) file perfect for further analysis in tools like Excel and R.  The Skyline Results and 

Document Grids provide Live access to many of these values and allow you to edit custom annotations 

as you work with your data. 

The first part of this tutorial will focus on Skyline custom reports.  You will learn how they can be 

designed, shared and used to export raw values and summary statistics from your Skyline documents.  

Exported reports can be used in the following ways: 

 Deeper statistical analysis in tools like Excel or R 

 Broader statistical analysis across multiple experiments and/or laboratories 

 Enforcing instrument quality control with summary statistics 

 Providing an input format for other custom build software tools 

 Providing an import format suited to relational data repositories 

In developing Skyline we aim to create a vendor-neutral platform for targeted proteomics investigation.  

Skyline can export similar custom reports for documents populated with the data from Agilent, AB Sciex, 

Bruker, Thermo-Scientific and Waters instruments.  The ability to create consistent reports across 

instrument platforms greatly facilitates cross-instrument comparisons and large multi-site studies. 

Understanding how to create custom reports, tailored to your own experiments, is critical and described 

in detail in this Skyline custom reports tutorial. 

The second part of this tutorial will focus on the Results and Document Grid views in Skyline, which 

provide real-time access to many of the data fields available in the custom reports.  You will learn to 

customize columns in the Results and Document Grids for immediate access to important values, as you 

inspect and refine your mass spectrometer output in Skyline.  You will also learn to work with custom 

annotations to provide a controlled vocabulary for further interpretation of and human interaction with 

your results, which can also be exported in custom reports. 

Getting Started 
To start this tutorial, download the following ZIP file: 

https://skyline.gs.washington.edu/tutorials/CustomReports.zip  

Extract the files in it to a folder on your computer, like: 

https://skyline.gs.washington.edu/tutorials/CustomReports.zip


2 
 

C:\Users\brendanx\Documents 

This will create a new folder: 

C:\Users\brendanx\Documents\CustomReports 

Now open the Study7_example.sky file in this new folder by double-clicking, or by using Open on the 

File menu in a running instance of Skyline. 

Data Overview 
The dataset in Study7_example.sky is a subset of a study that was performed by the Clinical Proteomics 

Technology Assessment for Cancer (CPTAC) consortium (T. Addona et al “Multi-site assessment of the 

precision and reproducibility of multiple reaction monitoring–based measurements of proteins in 

plasma”, Nature Biotechnology, 2009, 27, 633 - 641).  This particular study describes a calibration curve 

at different concentrations of analyte peptides and a constant spike in level of their corresponding 

isotope labeled internal standards.  

The Skyline file displays data from a subset of CPTAC Study 7.2 data (in the paper referred to as “Study 

II”) acquired at one CPTAC site.  The Skyline file shows data for 10 different peptide sequences 

monitored by LC-MRM-MS with concentrations for the analyte proteins (see light peptides) ranging from 

concentrations at 500 fmol to 2.92 fmol (replicates J: 500 fmol; I: 275 fmol; H: 151 fmol; G: 83 fmol; F: 46 

fmol; E: 25 fmol; and D: 8.55 fmol – lower concentration points although acquired are not included in 

this tutorial).  Heavy internal standard (IS) peptides are each spiked in at a concentration of 50 fmol. 

To get a first impression what this dataset looks like perform the following steps: 

 Click on the ‘HGFLPR’ peptide to highlight it. 

 On the View menu, choose Peak Areas, and then click Replicate Comparisons. 

A new window appears that shows peak area for each replicate.  The blue bars represent the heavy 

labeled version of this peptide (always spiked in at 50 fmol), and the red bars represent the light analyte 

at varying concentrations (each concentration point was acquired in technical quadruplicate). 

Other tutorials describe how you can view and edit documents like this one.  For the purposes of this 

tutorial, however, the Study7_example.sky document has received an initial integration review, fully 

preparing if for reports to be exported and used in deeper statistical analysis.  Before continuing with 

the rest of the tutorial: 

 Close the Peak Areas view. 

Creating a Simple Custom Report 
To create your first Skyline custom report template, perform the following steps: 
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 On the File menu, choose Export, and click Report 

An Export Report form will appear that will probably list at least the Skyline default report templates 

shown below: 

  

Continue creating a new Skyline custom report template by performing the following steps: 

 Click the Edit list button.  

 In the Edit Reports form, click the Add button. 

 In Edit Report form, enter ‘Overview’ in the Report Name field. 

The form should now look like:  
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 Expand the field groups Peptides and Replicates by clicking on the ‘+’ button to see many more 

fields that can be exported. 

 From the expanded Peptides group click the checkbox next to the PeptideSequence field. 

The form should now look like:  
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Note that the fields in the Edit Report form, shown above, have a distinct hierarchical structure.  At the 

highest level are the protein specific export fields which are shown at the bottom of the left box 

(ProteinName, ProteinDescription, ProteinSequence, ProteinNote, and the expanded Replicates group 

below these that contains the general field ReplicateName).  Skyline custom reports also provide 

peptide specific export fields, contained in the expanded Peptides group at the top of the left box, such 

as PeptideSequence and AverageMeasuredRetentionTime among others.  The peptide fields include a 

PeptideResults group, which is not expanded yet.  Also unexpanded is the Precursors group, which 

contains precursor specific export fields, a PrecursorsResults group, and finally a Transitions field group.  

The Transitions group, in turn, contains the transition specific export fields and a corresponding 

TransitionResults group, containing the most detailed results values, such as Retention Time, Fwhm, 

StartTime, EndTime, Area and Background, from which many of the higher level results field values are 

derived . 

In the Edit Report form continue to add fields to your first custom report template by performing the 

following steps: 
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 Expand the Precursors group (located directly below the expanded Peptides group at the very 

top) by clicking on the ’+’ icon. 

 Expand the PrecursorResults group field now visible in the expanded Precursor group. 

 Click the checkbox next to the IsotopeLabelType field from the expanded Precursors group.  (If 

necessary, scroll down or resize the form.) 

 Repeat this procedure to add the following additional fields from the precursor 

PrecursorResults group to the report template column list: 

o BestRetentionTime - the RetentionTime value of the transition with the highest 

maximum intensity for the particular precursor 

o TotalArea - the summed Area values of all individual transitions for the particular 

precursor (for more information on field values, see Glossary) 

 Check the Pivot Replicate Name check box in the lower left corner of the Edit Report form. 

This should leave the Edit Report form looking like:  
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 Click the Preview button in the upper right corner of the Edit Report form. 

The Preview form should appear looking like:  
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The Preview function is quite helpful when designing report templates.  At times it may even serve as a 

quick substitute for exporting a report to a file, since you can select all of the values in the Preview form 

by clicking the upper-left rectangle.  Pressing Ctrl-C, then copies the full report.  After which, it can be 

pasted into another tool, like Excel.  

The report preview displayed in part above, for replicates 7_2_D_01, and 7_2_D_02, shows precursor 

BestRetentionTime and TotalArea for all 10 peptides in both their light and heavy form across all LC-

MRM-MS acquisitions/experiments in the columns to the right.  By scrolling to the right, you can see 

columns for all 28 LC-MRM-MS acquisitions.  Maximize the Preview form by clicking on the square in its 

upper right corner to see more columns.  In this example 7_2_D_01, and 7_2_D_02 are taken from 

samples at the same light analyte concentration.  Therefore, TotalArea values are expected to be similar.  

Each letter D through J indicates a different light analyte concentration.  Each concentration was 

acquired in technical quadruplicate, indicated by numbers 01 through 04. The heavy peptide 

concentrations were held constant at 50 fmol in all samples. 

Close the Preview Report form by clicking on the ‘x’ in the upper right corner to return to the Edit 

Report form again.  To save this report template: 

 Click the OK button. 

You will see the new Overview report template appear in the Report template list.  
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 Click the OK button again to return to the Export Report form. 

The new Overview report template is now added to the Skyline report template list.  The Export Report 

form should now look like:  
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From the Export Report form you can now export your new report by selecting ‘Overview’ in the Report 

list and clicking the Export button.  For now, click the Cancel button, dismissing all open forms, in order 

to start the process from the original Skyline document view. 

Exporting Report Data to a File 
To export the report you created and previewed above to a CSV file, do the following:  

On the File menu, choose Export, and click Report. 

 Select ’Overview’ in the Report list of the Export Report. 

 Click the Export button. 

 Enter ‘Overview_Study7_example.csv’ in the File name field of the Export Report save form. 

 Click the Save button.  

If you switch to a Windows Explorer window, showing the CustomReports folder you created for this 

tutorial, you will see the Overview_Study7_example.csv file you just created.  Open it now with Excel 

and confirm that its contents are quite similar to the preview you displayed earlier.  Note that the file 

contains the column header names, which you cannot get by simply copying and pasting from the 

preview form.  

Sharing Report Templates 
Report Templates in Skyline are very flexible, easy to manage and modify, and share with collaborators.  

There are many reasons you might want to share a custom report template, whether you are 

participating in a large multi-laboratory study or working with a single collaborator, whether you are 

providing the proteomics community with your own custom tool that depends on particular fields from 

Skyline documents or providing supplementary information with a manuscript to allow others to repeat 

your protocols.  The Skyline support for instruments from multiple vendors means your shared report 

templates can be used to gather data from multiple sites with different instrumentation. 

To share the Skyline report template you created in this tutorial, perform the following steps: 

 On the File menu, choose Export, and click Report. 

 Click the Share button in the Export Report form. 

Skyline will present the Save Report Definitions form, as shown below:  
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 Check ‘Overview’ in the report definitions list. 

 Click the OK button. 

 Enter ‘Overview’ in the File name field of the Save As form. 

 Click the Save button. 

The report template is saved to the file Overview.skyr in the CustomReports folder created for this 

tutorial.   You could now share it with your collaborators, with your own analysis tool or as 

supplementary data for a manuscript.  

Managing Report Templates in Skyline 
To gain an understanding of how others would use the custom report template you have now created 

and shared, you need to first delete it from your system.  Then you can add it back using the shared 

report file Overview.skyr that you created in the previous section, as if you had acquired this shared 

template from another source.  

The Export Report form should still be open after the steps performed in the previous section.  To 

delete the ‘Overview’ report template from your Skyline settings, do the following: 

 Click the Edit List button. 

 Select the ‘Overview’ item in the Report list of the Edit Reports form. 

The Edit Reports form should now look like:  
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You can use the Up and Down buttons to change the order of the items in the Report list.  To move the 

‘Overview’ item to the bottom of the list, do the following:  

 Click the Down button twice. 

 Click the Up button three times to move the ‘Overview’ item to the top. 

To remove the ‘Overview’ item from the list, do the following:  

 Click the Remove button. 

 Click the OK button. 

The Export Report form should now look like:  
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Just as when you first brought it up in this tutorial.  

To demonstrate how your collaborators would import a new report template into Skyline follow the 

steps described below:  

 Click the Import button. 

 Select the ‘Overview.skyr’ file you created earlier in the Open form (which should still be 

showing the contents of the ‘CustomReports’ folder for this tutorial). 

 Click the Open button. 

These actions should add an ‘Overview’ item back to the Report list in the Export Report form.  To verify 

that this is indeed the report you saved, perform the following steps:  

 Select the ‘Overview’ item in the Report list. 

 Click the Preview button. 

 

Skyline will present a Preview Report form containing the same values you saw earlier in this tutorial. 

Modifying Existing Report Templates 
You can, of course, create much more data rich reports than the simple ‘Overview’ report you first 

created in this tutorial.  You can do this by creating another new report template, by editing your 

existing ‘Overview’ report, or, as shown below, by making a copy of the ‘Overview’ report and editing 

the copy.  To create a new, more complex report from a copy of the ‘Overview’ report template, 

perform the following steps: 
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 Click on Edit List button in the Export Report form. 

 Select the ‘Overview’ item in the Report list. 

 Click on the Copy button. 

Skyline will present the Edit Report form with the fields from the ‘Overview’ report template already 

added, as shown below:  

  

The report name for this new report template has not yet been assigned.  To assign it now:  

 Enter ’Study 7’ in the View Name field. 

Continue to add more fields as described below by clicking the checkbox next to each field to add each 

field to the column list for your report template, on the right side of the Edit Report form:  

 Expand the field groups Peptides and Results by clicking the ‘+’ icons to their left. 

 From the expanded Results group, add the following fields: 

o FileName – the name of the file from which the data was imported 

o SampleName – the sample name, if the data was imported from a multi-sample WIFF 

file, or the file name again, if not 

o ReplicateName – the replicate name assigned to the data during import 

 From the top level add ProteinName. 

 From the expanded Peptide group, add the AverageMeasuredRetentionTime field – the 

average retention time over all replicates. 

 Expand the Results group in the expanded Peptide group. 
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 From the expanded peptide Results group, add the following fields: 

o PeptideRetentionTime – peptide RT for each replicate run 

o RatioToStandard – area ratio of light to heavy 

 Expand the Precursors group. 

 From the expanded Precursors group, add the following fields: 

o Charge (displayed in the column list as PrecursorCharge) 

o Mz (displayed in the column list as PrecursorMz ) 

 Expand the Transitions group. 

 From the expanded Transitions group, add the following fields: 

o ProductCharge 

o ProductMz 

o FragmentIon – the fragment ion name (e.g. y8, y10, b7, etc.) 

 Expand the Results group in the Precursors group. 

 From the expanded precursor Results group, add the following fields: 

o MaxFhwm - the maximum full width at half max (FWHM) of the transitions for the 

particular precursor 

o MinStartTime - elution time start at the baseline of a peak, which will be the same for 

all transitions (Q1/Q3) from the same precursor 

o MaxEndTime - elution time start at the baseline of a peak, which will be the same for all 

transitions (Q1/Q3) from the same precursor 

 Expand the Results group in the Transitions group. 

 From the expanded transition Results group, add the following fields: 

o  RetentionTime – retention time at the maximum intensity for a transition peak 

o Fwhm – full width at half max for the transition peak 

o StartTime – retention time at the starting transition peak integration boundary 

o EndTime – retention time at the ending transition peak integration boundary 

o Area – area under the curve (AUC), minus background, for the transition peak 

o Height – maximum intensity for the transition peak 

o UserSetPeak - indicates whether or not (TRUE/FALSE) integration borders for a 

transition were manually adjusted   

 Also, uncheck the Pivot Replicate Name checkbox, at the bottom of the form. 

The report template should now contain a lot more detail than the original ‘Overview’ report template, 

and the Edit Report form should look like:  
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To reorder some fields in this new report template, do the following:  

 Select ProteinName in the column list on the right. 

 Click the up arrow on the far right until the ProteinName field is at the top of the list. 

You can achieve whatever ordering suits you best, in this way, using the up and down arrow buttons on 

the far right, and you can remove fields you may have added by mistake with the red ‘X’ button above 

the arrow buttons.  This tutorial, however, will continue without making any further changes to the 

column list.  

To preview the values for the current document in the report template you have created, do the 

following:  
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 Click on the Preview button. 

 When you have reviewed the data, close the preview form. 

With data like this, where each peptide has both a light analyte and a matching heavy isotope labeled 

internal standard, it may be more convenient to work with the data for these paired precursors all in a 

single row to allow you to compare matching transition values more easily.  

To make this change to the ‘Study 7’ report template, do the following: 

 Check the Pivot Isotope Label check box.  

 Click on the Preview button again to see how the report preview has changed. 

All of the values for matching light and heavy transitions have been added to the same row.  New 

columns have been added to achieve this, and columns specific to an isotope label type have been given 

the prefixes ‘light’ and ‘heavy’.  

The Preview form is shown below, scrolled to show the transition between ‘light’ and ‘heavy’ column 

names: 

  

You might notice that the column ‘heavy IsotopeLabelType’ shows ‘heavy’ on every row, and that there 

is also a column ‘light IsotopeLabelType’ which shows ‘light’ on every column.  When you are pivoting on 

a column, it does not add much to include it in your column list.  Close the Preview form, and do the 

following to remove the ‘IsotopeLabelType’ field from this report: 

 Select ‘IsotopeLabelType’ in the column list on the right.  

 Click the red ‘X’ button on the far right edge of the column list. 
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You can click the Preview button again to verify that both the ‘light IsotopeLabelType’ and the ‘heavy 

IsotopeLabelType’ columns have been removed.  The next step in this tutorial, however, is to save your 

work by doing the following: 

 Click the OK button in the Edit Report form.  

 Click the OK button in the Edit Reports form. 

This will return you to the Export Report form, which should now look like: 

  

From here, you could now continue to export the new ‘Study 7’ report to a CSV file by selecting it and 

clicking the Export button, or click Share button to create file for sharing this new report.  For this 

tutorial, however, click the Cancel button to return to the ‘Study7_example’ document. 

Quality Control Summary Reports  
So far you have created reports based on the values Skyline offers for each imported replicate of the 

peptides and transitions specified in a document.  Skyline also provides report fields with summary 

statistics across all imported replicates.  These summary fields are particularly suited to quality control 

by ensuring that replicate QC runs show good reproducibility and coefficients of variation (CV).  Skyline 

report templates can be designed with mean values and CV over all replicates for key parameters, such 

as peak area, FWHM and retention time. 

This tutorial provides a summary report template that you will import into Skyline, but it also describes 

how to design such a summary report template in the Edit Report form. 

To get started, first open a new document by doing the following: 
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 On the File menu, click Open. 

 Navigate to the ‘CustomReports’ folder you created for this tutorial.  (may not be necessary) 

 Select the ‘Study9pilot.sky’ file. 

 Click the Open button. 

This file contains data acquired by one CPTAC site over 5 LC-MRM-MS runs, injecting 10 analyte peptides 

at a constant concentration of 50 fmol over all 5 runs.  Such a dataset could potentially be used to assess 

reproducibility of replicate injections.  In this part of the tutorial you will begin working with Live 

Reports, using the report to navigate around the document.  To do this you will use the Document Grid 

functionality instead of Export Report. 

To view the data for key quality control metrics follow the steps below:  

 On the View menu, choose Document Grid. 

 At the top of the Document Grid form, click the Views button.  A dropdown list will appear.. 

 Choose Manage Views from the dropdown list. 

 Click the import button in the Manage Views form 

 Select the Summary_stats.skyr file from the ‘CustomReports’ folder in the Open form.  

 Click the Open button. 

A new view named ‘Summary Statistics’ should have been added to the View list, and the Manage 

Views form should now look like:  

  

Click OK to dismiss the Manage Views form. 
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Then, on the Document Grid form, click the Views button and choose Summary Statistics 

 

After you choose Summary Statistics, the document grid should look like the following: 

 

This report shows that the data in Study9pilot.sky, taken from 5 replicate injections of the same sample, 

produce peptide CV values for FWHM mostly below 5% and TotalArea in most cases under 10% as 

indicated for the corresponding columns with red boxes.  In addition, the column called 
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RangeBestRetentionTime (red box) lists the RT drift in minutes for any specific peptide over the 5 

replicate injections.  In this case there is only minimal RT drift (< 0.15 min, < 10 sec).  

These summary reports can be used to flag quality control issues early, before they impact data 

acquired on important samples.  In this particular dataset, HPLC and MS seem to behave acceptably.  In 

one case, however, for the peptide INDISHTQSVSAK (from protein LEP), the CV value for TotalArea is 

59.2% and for FWHM is 23.5% (circled in red), significantly differing from the CV values of all the other 

peptides. 

You can add a filter to this view so that only rows matching specific criteria are shown by doing the 

following: 

 Choose Edit View from the Views dropdown. 

 In order to find the CvTotalArea column in the tree view on the left, double click on that column 

in the list on the right. 

The Customize View form should look like: 

 

To define a new filter on this view: 

 Click the Filter tab.  The CvTotalArea column will still be selected in the tree view on the left. 

 Click the Add >> button to add that column to the list of filters. 
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 Set the Operation to Is Greater Than 

 In the Value column, enter ‘.2’. 

The Customize View form should look like: 

 

Note that even though the CvTotalArea column is displayed as a percentage in the Document Grid, on 

the filter tab, the number “20%” is represented as “.2”. 

 Click the OK button on the Customize View form to see the rows matching this filter. 
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To inspect this peptide more closely, do the following:  

 Close the Document Grid by clicking the red X in the upper right corner. 

 Select the peptide ‘INDISHTQSVSAK’ in the peptide tree view. 

 On the View menu, choose Peak Areas, and click Replicate Comparison (F7).  
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The Peak Areas view, showing the total peak area and the contribution of each transition for all 5 

replicates, help clarify the problem that was indicated in the CV values of the summary report preview.  

For comparison, select several of the other peptides.  The Peak Areas view will show much better peak 

area reproducibility, as indicated by their much lower TotalArea CV values in the summary report 

preview, where the majority of the peptides had CV values < 10%. 

 

Skyline summary reports can be used with quality control data to flag issues early, while Skyline itself 

provides powerful visual displays to help get to the root of the problem quickly.  

Results Grid View 
In some cases, you may want to see some of the values presented in reports while you are editing the 

data, for immediate access to raw values displayed in the Skyline charts.  The Skyline Results Grid view 

provides real-time access to many of the data fields available in the custom reports.  In the final sections 

of this tutorial, you will learn to use the Results Grid to gain immediate access to important values and 

to annotate your data to capture important human insights, as you inspect and refine your mass 

spectrometer output in Skyline. 

To get started using the Result Grid view, do the following: 

 On the View menu, click Results Grid (Alt-F2). 
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Skyline should now look something like this: 

 

Now rearrange the windows for better viewing, by doing the following: 

 Click the Results Grid caption and drag it to the bottom edge of the main window to dock it.  

 Click the Peak Areas caption and drag it to the right edge of the main window to dock it. 

 Click and drag the splitters between the various window panes to adjust the space allocation. 

 On the View menu, choose Auto-Zoom, and click Best Peak, if it is not already selected. 

 Select the precursor element ‘467.2440+++’ below the currently selected peptide. 

This should leave Skyline looking something like: 



26 
 

  

Skyline keeps its charts and the Results Grid in synch as you navigate the data.  If you click on one of the 

other rows in the Results Grid, Skyline changes the active chromatogram replicate tab.  It also changes 

which bar in the Peak Areas graph has the selection rectangle around it, as well as the selection in the 

Replicates list above the peptide tree view.  Now click on a different chromatogram chart tab, bar in the 

Peak Areas chart, or change the selection in the Replicates list.  The other views will update, including 

the selected row in the Results Grid.  

The first column to the right of the Replicate column in the Results Grid is the PrecursorReplicateNote.  

This column allows you to associate a free text note with the PrecursorResults field group for the 

selected precursor and replicate.   

 Type ‘Low signal’ in the first row with replicate name ‘Rep1’ for the currently selected peptide.  

The Results Grid should now look like: 
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All of the other columns in the current Results Grid display are calculated by Skyline and cannot be 

edited, but you can change which columns get displayed and in what order.  Several of the columns are 

scrolled out of view in the image above.  To reduce the number of precursor results columns being 

displayed, do the following: 

 From the Views dropdown at the top of the Results Grid, choose Edit View 

 On the Customize View form, for each of the columns Min Start Time, Max End Time, and 

Library Dot Product, click on the column name in the list box, and then click on the X button to 

the right of the list box. 

 Click the OK button. 

You can now review the results for other precursors by doing the following: 

 Click in the peptide tree view. 

 Use the up and down arrow keys to change the selection to other precursor elements. 

Finally expand a precursor and review its transitions.  You could apply the same technique to customize 

the columns being displayed for transitions.  Instead, continue now to the final section in this tutorial to 

learn how to add a custom annotation that you can control with the Results Grid, and later export in a 

Skyline report. 

Custom Annotations 
Skyline supports three types of custom annotations: 

1. Free text (similar to the Note which is available by default on all types) 

2. Number 

3. True/False 

4. Value list 

The last two types can be used to collect information in a controlled vocabulary, as you process your 

data, which can later be exported in a Skyline report and used as input for programmatic statistical 

analysis. 
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To define a simple new True/False annotation, perform the following steps: 

 On the Settings menu, click Annotations. 

 Click the Edit List button on the Annotation Settings form. 

 Click the Add button on the Define Annotations form. 

 Type ‘Tailing’ in the Name field on the Define Annotation form. 

 Select ‘True/False’ in the Type field. 

 Check the Precursor Results checkbox in the Applies To list. 

The Define Annotation from should now look like: 

    

Now finish defining the annotation and add it to your document by doing the following: 

 Click the OK button on the Define Annotation form. 

 Click the OK button on the Define Annotations form. 

 Check the checkbox for the new ‘Tailing’ annotation. 

The Annotation Settings form should now look like: 
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 Click the OK button. 

Select the second to last precursor element ‘564.7746++’ for the peptide ‘ESDTSYVSLK’. 

The new Tailing column will not have been added to the custom view in the Results Grid, but you can 

add it: 

 Choose Edit View from the Views dropdown at the top of the Results Grid. 

 In the list view on the right, click on the third column down (“PrecursorPeakFoundRatio”).  This 

will affect where in the list new columns get added. 

 Click the checkbox next to Tailing at the bottom of the tree view on the left. 

The Customize View form should now look like the following: 
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 Click the OK button. 

You should see the new Tailing column added to the Results Grid between PrecursorReplicateNote and 

PrecursorPeakFoundRatio 

The Skyline window should now look something like: 
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The peaks in this document do not have a lot of issues, but this one does have some peak tailing.  Check 

the checkbox in the new Tailing column for the ‘Rep1’ row.  Change selection to each of the other 5 

rows.  Decide whether you think the tailing is worth noting and check the checkbox, if you think it is.  

Change the selected item in the precursor tree and then return to the ‘564.7746++’ precursor to verify 

that your changes were recorded. 

You can now export the new Tailing annotation in a Skyline custom report.  It will appear in the 

PrecursorResults field group. 

Conclusion 
This tutorial has introduced you to the flexible custom reports Skyline offers for accessing the rich set of 

values associated with your Skyline targeted proteomics documents.  These reports offer a smooth path 

from data analysis within Skyline to more complex statistical analysis with Excel or custom programs in 

R, Matlab, Java or C++.  You have learned about summary statistics available through these report 

templates, which can provide quick indicators of data quality.  You can share your custom report 

templates with collaborators or as supplementary material in your publications, helping others to repeat 

your analyses with new data sets even from different instrumentation, taking full advantage of the 

Skyline multi-vendor support.  Finally, you learned how to use the Skyline Results Grid to gain immediate 
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access to many of the values available in Skyline reports and to work with custom annotations to add 

rich new information to your documents.  If you were not aware of these features before, they will 

certainly increase the scope of experiment you can achieve with Skyline. 

Glossary of Custom Report Fields 
 Proteins (top level): 

o ProteinName – Protein Name as defined or entered into Skyline (in some cases in 

conjunction with the accession number).   

o ProteinDescription – When proteins are imported into Skyline through public FASTA 

sequence files, a Protein Description is provided.  You can see the Protein Description 

also when you hover over the protein name in the peptide tree view. 

o ProteinSequence – When proteins are imported into Skyline through public FASTA 

sequence files the full protein sequence is accessible.  You can see the protein sequence 

also when you hover over the protein name in the peptide tree view. 

o ProteinNote – A free text note associated with the protein by clicking Edit Note on the 

Edit menu. 

o [Protein Annotations] – Annotations defined as applying to “Proteins” appear here. 

 

 Results (top level): 

o ReplicateName – The replicate name assigned to the data during import. 

o ReplicatePath –  Reserved for future use. 

o FileName – The name of the file from which the data was imported. 

o SampleName – The sample name, if the data was imported from a multi-sample WIFF 

file, or the file name again for other file types. 

o ModifiedTime – Last time and date at which the original mass spectrometer file was 

modified on disk. 

o AcquiredTime – Last time and date at which the mass spectrometer began acquiring this 

replicate data.  Or #N/A if the file was imported with a version older than 1.1. 

o [Replicate Annotations] – Annotations defined as applying to “Replicates” appear here. 

 

 Peptides: 

o PeptideSequence – Amino acid sequence of the peptide . 

o PeptideModifiedSequence – Amino acid sequence annotated with only structural 

modification delta masses (e.g. AC[+57]GR). 

o BeginPos – The position of the first (N-terminal) amino acid of the peptide within its 

containing protein sequence, or #N/A if no protein sequence is available. 

o EndPos – The position of the last (C-terminal) amino acid of the peptide within its 

containing protein sequence, or #N/A if no protein sequence is available. 

o MissedCleavages – The number of missed cleavage sites in the peptide sequence. 

o RetentionTimeCalculatorScore – The raw score for the peptide from the current 

retention score calculator, if one is used (e.g. SSRCalc or iRT score) 
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o PredictedRetentionTime – The retention time predicted by a retention time regression 

between a set of measured results and a retention time calculator (currently only 

SSRCalc 3.0 is available), or #N/A if no retention time regression has been assigned. 

o AverageMeasuredRetentionTime – The average peptide retention time over all 

replicates. 

o PeptideNote – A free text note associated with the peptide by clicking Edit Note on the 

Edit menu. 

o [Peptide Annotations] – Annotations defined as applying to “Peptides” appear here. 

 

 PeptideResults (per replicate values): 

o PeptidePeakFoundRatio – The ratio of transitions for which a peak was measured to the 

total number of transitions in the peptide.  Peak indicators in the peptide tree view 

correspond to green = 1.0 (all transitions integrated), orange >= 0.5, red < 0.5. 

o PeptideRetentionTime – Peptide retention time for each replicate run. 

o PredictedResultRetentionTime – Retention time predicted for this specific replicate 

based on retention time alignment of iRT values. 

o RatioToStandard – Peptide area ratio of light to heavy. 

o BestReplicate – True if this replicate has the highest overall peptide peak score. 

 

 Precursors: 

o Charge/PrecursorCharge – The charge associated with the precursor ion.  

o IsotopeLabelType – A label type name associated with the precursor ion (light/heavy), 

indicating which isotope modifications are applied. 

o PrecursorNeutralMass – Neutral mass of the precursor in Daltons. 

o Mz/PrecursorMz –The mass to charge ratio (m/z) of the precursor ion.  

o CollisionEnergy - Collision Energy for the precursor ion according to instrument/vendor 

specific default collision energy equation within Skyline. 

o DeclusteringPotential - Declustering Potential for the precursor ion according to 

instrument/vendor specific default declustering potential equation within Skyline. 

o ModifiedSequence - Peptide sequence including any amino acid modifications such as 

cysteine alkylation. (example:  AGLC[+57]QTFVYGGC[+57]R) 

o PrecursorNote – A free text note associated with a precursor by clicking Edit Note on 

the Edit menu. 

o LibraryName – The name of a MS/MS spectral library, if a MS/MS spectral library 

spectrum is associated with the precursor ion. 

o LibraryType – The type of MS/MS spectral library (BiblioSpec, GPM, NIST), if a MS/MS 

spectral library spectrum is associated with the precursor ion. 

o PrecursorLibraryRank – A MS/MS spectral library ranking of the precursor among other 

precursors for a protein that match supplied spectral libraries, using a score specified in 

the peptide library settings. 

o LibraryScore1 – Raw peptide library score that may or may not be used to rank among 

precursors of a protein. 
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o LibraryScore2 – Raw peptide library score that may or may not be used to rank among 

precursors of a protein. 

o LibraryScore3 – Raw peptide library score that may or may not be used to rank among 

precursors of a protein. 

o IsDecoy/PrecursorIsDecoy – True if this is a decoy precursor. 

o DecoyMzShift/PrecursorDecoyMzShift – Shift in m/z applied to the precursor to create 

the decoy m/z. 

o [Precursor Annotations] – Annotations defined as applying to “Precursors” appear here. 

 

 PrecursorResults (per replicate values): 

o PrecursorPeakFoundRatio – The ratio of transitions for which a peak was measured to 

the total number of transitions in the precursor.  Peak indicators in the peptide tree 

view correspond to green = 1.0 (all transitions integrated), orange >= 0.5, red < 0.5.  

o BestRetentionTime – The RetentionTime value of the transition with the highest 

maximum intensity for the precursor.  

o MaxFwhm – The maximum full width at half max (FWHM) of the transitions for the 

precursor.  

o MinStartTime – Minimum StartTime of all transitions for a precursor.  Unless manually 

edited all transitions for a precursor use the same integration boundaries. 

o MaxEndTime – Maximum EndTime of all transitions for a precursor.  Unless manually 

edited all transitions for a precursor use the same integration boundaries.  

o TotalArea – The summed Area values of all individual transitions for the particular 

precursor.  

o TotalBackground – The summed Background values of all individual transitions for the 

particular precursor. 

o TotalAreaRatio – The ratio of the TotalArea of this precursor to the first internal 

standard label type, before version 0.7 this was always light/heavy, and appeared on the 

heavy precursor. 

o TotalAreaNormalized – The TotalArea normalized to the sum of the TotalArea values 

for all peptide precursors in the document. 

o CountTruncated– The number of transitions for a precursor that integrate a peak with a 

boundary at either end of the acquisition time range, where intensity at the end is 

greater than 1% of the entire peak height higher than the other extent. 

o Identified – True if a MS/MS peptide identification exists for the result file at a time 

between the peak integration boundaries.  (new in v1.2) 

o LibraryDotProduct – The dot-product (described by Wikipedia 

http://en.wikipedia.org/wiki/Dot_product) between the individual transition peak areas 

of the precursor and the intensities of the matching ion peaks in the matched MS/MS 

spectral library spectrum (Note: as of v1.4, this is now 1 – Arcos(dotp)/(Pi/2) where dotp 

is the value described above. a.k.a. Normalize Spectrum Contrast Angle), or #N/A if the 

precursor has not matching library spectrum or has fewer than 4 transitions.  This is a 

http://en.wikipedia.org/wiki/Dot_product
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useful value for method refinement.  It works best when 6 or more transitions are 

present. 

o IsotopeDotProduct – The dot-product calculation described above, but between the 

individual precursor (M, M+1, M+2, etc.) peak areas of the precursor and the intensities 

of the predicted isotope distribution, or #N/A if the transition is not a precursor isotope, 

or the chromatogram was not extracted from high resolution MS1 data.  (new in v1.2) 

o UserSetTotal – True if the default choice of peak or its boundaries was manually altered.  

o OptStep – Optimization step value indicating distance from the default value for the 

parameter being optimized, 0 for the default parameter value, or if no optimization is 

being performed in the replicate. 

o OptCollisionEnergy – The collision energy value corresponding to the OptStep if 

collision energy optimization is being performed. 

o OptDeclusteringPotential – The dlecustering potential value corresponding to the 

OptStep if declustering potential optimization is being performed. 

o PrecursorReplicateNote – A free text note associated with a result set of the precursor 

using the Results Grid. 

o [Precursor Results Annotations] – Annotations defined as applying to “Precursor 

Results” appear here. 

 

 PrecursorResultsSummary (summary statistics across all replicates):   

o MinBestRetentionTime – Minimum of the precursor BestRetentionTime values. 

o MaxBestRetentionTime – Maximum of the precursor BestRetentionTime values. 

o RangeBestRetentionTime – The difference between MaxBestRetentionTime and 

MinBestRetentionTime, which can be used to gauge the spread of retention times 

measured.  

o MeanBestRetentionTime – Mean of the precursor BestRetentionTime values. 

o StdevBestRetentionTime – Standard deviation of the precursor BestRetentionTime 

values. 

o CvBestRetentionTime – Coefficient of variation (CV) of the precursor 

BestRetentionTime values. 

o MeanMaxFwhm – Mean of the precursor MaxFwhm (peak width) values. 

o StdevMaxFwhm – Standard deviation of the precursor MaxFwhm (peak width) values. 

o CvMaxFwhm – Coefficient of variation (CV) of the precursor MaxFwhm (peak width) 

values. 

o MeanTotalArea – Mean of the precursor TotalArea values. 

o StdevTotalArea – Standard deviation of the precursor TotalArea values. 

o CvTotalArea – Coefficient of variation (CV) of the precursor TotalArea values. 

o MeanTotalAreaRatio – Mean of the precursor TotalAreaRatio values. 

o StdevTotalAreaRatio – Standard deviation of the precursor TotalAreaRatio values. 

o CvTotalAreaRatio – Coefficient of variation (CV) of the precursor TotalAreaRatio values. 

o MeanTotalAreaNormalized – Mean of the precursor TotalAreaNormalized values. 
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o StdevTotalAreaNormalized – Standard deviation of the precursor TotalAreaNormalized 

values. 

o CvTotalAreaNormalized – Coefficient of variation (CV) of the precursor 

TotalAreaNormalized values. 

 

 Transitions:   

o ProductCharge – Charge (z) of the product ion.  

o ProductNeutralMass - Neutral mass of the product ion peptide fragment in Daltons. 

o ProductMz – The mass to charge ratio (m/z) of the product ion. 

o FragmentIon – The name of the product ion peptide fragment (e.g. y8, y10, b7, etc.).  

o FragmentIonType – The type of the product ion (y, b, c, z, a, x, precursor) 

o FragmentIonOrdinal – Position of the amino acid in the peptide after (C-terminal of) 

which the peptide was cleaved upon fragmentation. (e.g. 8, 10, 7, etc.) 

o CleavageAa – Specific amino acid residue in the peptide after (C-terminal of) which the 

peptide was cleaved upon fragmentation. (e.g. P, M, S, T, etc.) 

o LossNeutralMass – The total mass of all neutral losses from this fragment. 

o Losses – A comma separated list of all neutral losses from this fragment. 

o TransitionNote – A free text note associated with the transition by clicking Edit Note on 

the Edit menu. 

o LibraryRank – The rank based on LibraryIntensity of this transition among all transitions 

allowed by the transition Filter settings, shown in the user interface as “(rank #)”. 

o LibraryIntensity – The MS/MS peak intensity corresponding to the transition product 

ion in the matching library spectrum. 

o IsotopeDistIndex – Zero for the monoisotopic peak, 1 for M+1, 2 for M+2, etc.  (new in 

v1.2) 

o IsotopeDistRank – The rank based on the IsotopeDistProportion among all isotope 

peaks for the predicted isotope distribution, shown in the user interface as “(irank #)”.  

Currently only available for precursor transitions filtered from high resolution MS1 

scans.  (new in v1.2) 

o IsotopeDistProportion – The proportion of the entire isotope distribution predicted for 

this isotope peak.  Currently only available for precursor transitions filtered from high 

resolution MS1 scans.  (new in v1.2) 

o IsDecoy/TransitionIsDecoy – True if this is a decoy transition. 

o DecoyMzShift/ProductDecoyMzShift – Shift in m/z applied to the product ion to create 

the decoy m/z. 

o [Transition Annotations] – Annotations defined as applying to “Transitions” appear 

here. 

 

 TransitionResults:   

o RetentionTime – Retention time at the maximum intensity for a transition peak. 

o Fwhm – Full width at half max (FWHM) for the transition peak.  
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o FwhmDegenerate – True if one of the peak integration boundaries intersects the 

chromatogram above the half maximum intensity. 

o StartTime – Retention time at the starting integration boundary for the transition peak. 

o EndTime – Retention time at the ending integration boundary for the transition peak.  

o Area – Area under the curve (AUC), minus background, for the transition peak. 

o Background – The area of the rectangle formed by the integration boundaries, and the 

baseline and a line perpendicular to minimum intersection intensity between the 

integration boundaries and the chromatogram for the transition peak. 

o AreaRatio – The ratio of the Area of this transition to its corresponding transition in the 

first internal standard label type, before version 0.7 this was always light/heavy, and 

appeared on the heavy transitions. 

o AreaNormalized - The Area normalized to the sum of the Area values for all transitions 

in the document. 

o Height – The maximum intensity of the points between the transition peak integration 

boundaries. 

o Truncated– True if the integrated a peak has a boundary at either end of the acquisition 

time range, where intensity at the end is greater than 1% of the entire peak height 

higher than the other extent.  Or #N/A if the data was imported with a version older 

than 1.1. 

o PeakRank – The rank based on Area of this transition among all other transitions of the 

same precursor. 

o UserSetPeak – True if the default choice of peak or its boundaries was manually altered.  

o TransitionReplicateNote - A free text note associated with a result set of the transition 

using the Results Grid. 

o [Transition Results Annotations] – Annotations defined as applying to “Transition 

Results” appear here. 

 

 TransitionResultsSummary (summary statistics across all replicates):   

o MinRetentionTime – Minimum of the transition RetentionTime values. 

o MaxRetentionTime – Maximum of the transition RetentionTime values. 

o RangeRetentionTime – The difference between MaxRetentionTime and 

MinRetentionTime, which can be used to gauge the spread of retention times 

measured.   

o MeanRetentionTime – Mean of the transition RetentionTime values. 

o StdevRetentionTime – Standard deviation of the transition RetentionTime values. 

o CvRetentionTime – Coefficient of variation (CV) of the transition RetentionTime values.  

o MeanFwhm - Mean of the transition Fwhm (peak width) values. 

o StdevFwhm - Standard deviation of the transition Fwhm (peak width) values. 

o CvFwhm - Coefficient of variation (CV) of the transition Fwhm (peak width) values. 

o MeanArea - Mean of the transition Area values. 

o StdevArea- Standard deviation of the transition Area values. 

o CvArea - Coefficient of variation (CV) of the transition Area values. 
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o MeanAreaRatio - Mean of the transition AreaRatio values. 

o StdevAreaRatio - Standard deviation of the transition AreaRatio values. 

o CvAreaRatio - Coefficient of variation (CV) of the transition AreaRatio values. 

o MeanAreaNormalized - Mean of the transition AreaNormalized values. 

o StdevAreaNormalized - Standard deviation of the transition AreaNormalized values. 

o CvAreaNormalized - Coefficient of variation (CV) of the transition AreaNormalized 

values. 


